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Conditions of use 
 
ParticleTR analysis program was developed to track moving particles in microscopy 
applications. However, it can also be used in any other imaging application in which 
the movement of any object in the image is of interest.  
 
 
Celica retains copyright and all rights are reserved. Unregistered use of ParticleTR is 
a violation of international copyright laws. Users may not rent or lease ParticleTR.  
 
 
 
The ParticleTR is provided �as is� and with no warranties of any kind. The content of 
this user�s guide is available for informational use only and is subject to change 
without notice. Celica assumes no responsibility or liability for any errors or 
inaccuracies that may appear in the ParticleTR software or the user�s guide.  
 
 
 
 
 
 
 
Celica, d.o.o.  
Stegne 21c 
SI-1000  
Ljubljana 
Slovenia 
 
 
phone: +386 (0)1 51 13 600 
fax: +386 (0)1 51 123 15 
e-mail: celica@siol.net 
 
 
 

URL: http://www.celica.si 
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1. Introduction and software installation 

1.1 Introduction 
 
ParticleTR is a particle tracking and analysis software which can be used to track 
moving objects in time lapse images. ParticleTR was developed primarily for tracking 
of moving fluorescent particles in microscopic time lapse images.  
 
The tracking algorithm is based on fitting of a two-dimensional Gaussian curve to a 
specified region of the image. The peak of the Gaussian two-dimensional function is 
recorded as the coordinates of the particle in each frame. 
 
ParticleTR is a menu driven program. It represents a powerful tool for fast automatic 
tracking of particles in time lapse images. The maximal number of particles in one 
image sequence is set to 50. The degree of user interaction during analysis depends 
on preferences of the user and on the type of images being analyzed. In images in 
which the same particles are present in all analyzed images and in which the paths of 
particles do not intercept, automatic tracking and analysis is straightforward.  
 
ParticleTR provides tools to analyze data and visualize results in 2D and 3D line 
charts. The measured coordinates of a particle position as a function of time 
represents a data source which can be further analyzed. Software calculates several 
parameters for each particle, such as: the total length of the trajectory, the total 
motion time, the average speed, the displacement and the index of 
displacement/total length of the trajectory. Software also calculates parameters of 
each frame for all particles analyzed: current time, step length, cumulative length, 
squared displacement and speed.  
 

1.1.1 Major features 

• Automatic tracking of particles in a series of time lapse images. 
• Verification of tracked coordinates and interactive determination  of 

coordinates. 
• Calibration of time and spatial dimensions. 
• Visualization of trajectories in 2D and 3D line charts. 
• Analysis of trajectories and line chart visualization of calculated parameters. 
• Zoom of image series to a specified region. 
• Intuitive user interface. 
• Export of trajectories and calculated parameters to an ASCII file. 
• Export  of  images together with trajectories to an AVI file. 

 
 

1.2 Installing the ParticleTR software 
 
Once you have closed all other Windows applications, you are ready to install 
ParticleTR. 
 
• Insert the ParticleTR installation CD into your CD drive or open the folder with the 

downloaded ParticleTR software. 
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• Double click the�Install.exe� icon.  
• Installation procedure will start and all ParticleTR program files will be copied to 

your hard disk. The setup program will create the C:\ ParticleTR folder. A 
ParticleTR program group containing the ParticleTR program icon will be created.  

• Start ParticleTR by clicking the icon.  
 

1.3 Hardware requirements 
ParticleTR is designed to run on Windows NT®, Windows 2000® and Windows XP®.  
 
To run ParticleTR you will require an IBM-PC compatible computer with at least Intel® 
Pentium III® class processor (higher recommended), minimum 128 MB RAM (256 MB 
RAM or more recommended) and an adequate hard disk capacity.  
 
A VGA or higher resolution video interface card and monitor with at least 800x600 
resolution is recommended.  
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2 Using ParticleTR 

Quick reference 

Import images 

To start working with ParticleTR, first import a series of images. Click Import images 
on the File menu. Input the number of images to import and input the path and name 
of the folder where the series of images is stored. To browse for the location of the 
folder, click the Browse button. When ready, press the Load button. If you do not 
input the number of images to import, all images in the folder will be imported. The 
images should be in the 8-bit grayscale tagged image file format (TIFF). 
 

Manual determination of particle position 

To start tracking particles on images, you should first determine which particle you 
wish to track. Select the particle number in the list box in the Toolbar. Select Manual 
determination of particle position in the Detection menu. A crosshair will appear 
on the screen. With the left-mouse-click determine the position of the vesicle which 
you would like to track. Coordinates will be stored and the next image appears on the 
screen, unless this option is cleared in the Options window under the Settings 
menu. You can proceed manually by determining the coordinates of particles. For 
quicker access to Manual determination of particle position you can use the Enter 
shortcut key. Please note that shortcut keys are available only if the image window is 
active (click on the image to activate it).  
 

Automatic detection of particle position 

After you have manually determined the coordinates of the particle, you can use the 
algorithm for automatic detection of coordinates on the next image. Select 
Automatic detection of particle position in the Detection menu or use the Right 
arrow shortcut key. After coordinates have been successfully determined and stored, 
you can proceed to the next image by the Up arrow shortcut key or any other 
navigation tool (see the Toolbar section).  
 

Continuous particle tracking 

To automatically track and to proceed to the next image, select Continuous particle 
tracking in the Detection menu or use the Double arrow button in Toolbar. The 
procedure will stop at the last image in the series. If you want to stop the procedure 
before it finishes the tracking, release the Double arrow button.  
 
Note that the speed of automatic detection depends on the type of computer 
processor and on the pause settings set in the Options window under the Settings 
menu.  
 

Saving trajectories 

When you have finished with or have discontinued the particle tracking, you can save 
coordinates of trajectories in an ASCII text file. This file is used for further tracking in 
the same set of images, for analysis by the ParticleTR software and for analysis by 
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any other software supporting the import of text files. To save trajectories use the 
Save trajectories file command in the File menu.  
 

Analysis  

ParticleTR provides tools to visualize and analyze trajectories. By selecting the 
Visualize checkbox in the Toolbar, trajectories will be superposed in the image. By 
pressing the Visualize 3D button, a 3D line chart will be opened. In addition to data 
with coordinates, other calculated parameters can be observed in a 2D line chart. 
ParticleTR estimates and displays any combination of time, step length in one frame 
interval, displacement from the origin and speed relative to the X- or Y-axis. 
Calculated data can also be saved to an ASCII text file. ParticleTR saves two files 
separately, one for detailed analysis for every time interval and the other for 
summary analysis for each particle. Please see chapter 2.2.6 Analysis Menu for 
details.  
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2.1 Toolbar 
The slider is used to select an individual image from a 
series of images. By clicking the Up or Down scroll arrow, 
the next image in series will be displayed. By clicking above 
or below the scroll box, software will skip nine images and 
display the tenth image. To scroll to a specific image, drag 
the scroll box, or type the number of the image in the upper 
text box with white background and press Enter.  
 
Select particle No. is the list menu where one of 50 particle 
number can be selected. The label of the current particle 
corresponds to the selected particle number.  
 
By pressing the Assign color button, the default color can 
be replaced by any other color. To apply a new color, click 
the color in the palette, or click Define custom colors for 
more colors. Note that the corresponding color of the 
current particle is also displayed in the small square in the 
top left corner of the image.  
 
To turn the display of trajectories on the image on or off, 
select or clear the Visualize check box.  
 
By pressing the Visualize 3D button, a three-dimensional 
line chart with trajectories will open. In the Tools menu click 
Rotate 3D or Move camera to position the chart to an 
appropriate perspective. 
 
To turn the display of particle numbers in the image on or 
off, select or clear the Label check box. Note that particle 
numbers are displayed only for particles which are detected 
and have their position determined on the current image 
(also encircled with a corresponding color).  
 
By pressing the Analysis button, a dialog box will open: 
�Analysis is started. Calibration has not been done. Would 
you like to do the calibration first?� Click �Yes� and type in 
the pixel dimension in micrometers and time interval of consecutive images in ms. 
When you press the Calibrate button, calibration factors will be stored and 
implemented. If you do not calibrate images, the unit of analysis results will be pixel 
instead of micrometer. A line chart window will open. Please see chapter 2.2.6 
Analysis Menu for details. 
 
In the Maximal step box enter the maximal expected dislocation of the particle in 
one frame interval. Pixels are units for this value. Eligible values are from 1 to 30, but 
in most cases values between 3 to 9 will allow software to successfully track 
individual particles. Select a lower value if many particles are in close proximity and a 
higher value if the expected maximal dislocation in one time interval is large. It is not 
possible to automatically track particles with large dislocation steps in one time 
interval if other particles are closer than the step size. To resolve this, one should 
acquire images at a higher frame rate.  
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 Pressing the double arrowhead button starts continuous particle tracking. The 
position of the particle is automatically detected, marked by the circular sight and the 
tracking is paused for a defined period (see the Settings chapter). The procedure is 
repeated continuously for all consecutive images until the end of the record or until 
the procedure is interrupted by releasing the button. Note that the continuous particle 
tracking procedure can operate only when the position of a particle in the preceding 
image is determined. The procedure is stopped in case the particle gets close to the 
border of the image (closer than the maximal step setting).  
 
Current length of step or path in specified units is displayed in two separate text 
boxes. Step length is the distance of particle movement in one time interval. Path 
length is the cumulative length of the particle�s travel from the start to the time point 
of the current image.  
 
If the Zoom on check box is checked, dragging with the left mouse button pressed 
will zoom the image to the specified rectangle. Uncheck the box to proceed with the 
particle tracking and analysis.  
 

2.2 Menus 
Menus are also accessible via keyboard commands as follows: 

• File (alt-F) 
• Edit (alt-E) 
• View (alt-V) 
• Track (alt-T) 
• Detection (alt-D) 
• Analysis (alt-A) 
• Settings (alt-S) 
• Help (alt-H) 

 

2.2.1 File Menu 

Import images  

Click Import images in the File menu to import a series of images. Input the number 
of images to import and input the path and name of the folder where the series of 
images is stored. To browse for the location of the folder, click the Browse button. 
When ready, press the Load button. If you entered the number of images which is 
lower than the number of all available images, you will be prompted: �Number of 
images in this directory is larger than the number of selected images. Do you want to 
input all images?� If you do not input the number of images to import, all images in 
the folder will be imported.  
 
The images should be in the 8-bit grayscale tagged image file format (TIFF). Only 
one series of images should be stored in one directory.  
 

Load trajectories 

If you previously analyzed the same set of images and saved the results to a 
trajectory file, you can open the saved trajectories and continue to track particles or 
to analyze results. To successfully load trajectories, you should not modify the 
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trajectories file by using any other software.  
 

Save trajectories file 

After tracking particles, you can save coordinates of all particles in all images in the 
ASCII text file by using the Save trajectories file option in the File menu. Data is 
organized in column pairs for x and y positions of the particle in the image. The origin 
of the coordinates is the top left corner of the image. First column of the pair in the 
file represents the horizontal distance of the particle and the second column of the 
pair represents the vertical distance of the particle. Units are pixels. All coordinates of 
separate images are organized in separate rows.  
Data can be imported in any numerical or text editing software which supports import 
of ASCII text files.  
 

Save trajectories file as 

If you want to save trajectories file under a different file name or to save them to a 
different location on your storage device, you can use the Save trajectories file as 
option in the File menu.  
 

Export AVI 

A sequence of images together with their trajectories can be exported into the AVI 
video file format. After selecting the Export AVI option, a new window is opened in 
which you can set the time interval of the movie (the first and last images of the 
movie), destination directory and filename under which the AVI file will be stored, and 
the frame rate (speed) of playback of the movie.  
 

 
 
 

Exit  

Closes the ParticleTR program. 
 

2.2.2 Edit Menu 

Copy all trajectories 

Copies all coordinates of all particles in all images in Windows clipboard as ASCII 
text. Data is organized in column pairs for x and y positions of the particle in the 
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image. The origin of the coordinates is the upper left corner of the image. The first 
column of the pair in the file represents the horizontal distance of the particle and the 
second column of the pair represents the vertical distance of the particle. Units are 
pixels. All coordinates of separate images are organized in separate rows. Data can 
be pasted into any numerical or text editing software. In frame positions where 
coordinates of a certain particle are not determined, the �NaN� sign is inserted.  
 

Copy current trajectory 

Copies coordinates of the current particle. See �Copy all trajectories� chapter for 
details.  
 

2.2.3 View Menu 

View/hide labels  

Toggles display of numerical labels of tracked particles. Labels appear next to the 
center of the particle.  

View/hide trajectories 

Toggles the 2D display of all trajectories (path) on/off in all frames analyzed.  

View 3D trajectories  

Opens a separate window with 3D display of all trajectories.  

 

Show/hide step length 

Toggles display of the current step length in one frame interval on/off. In 
noncalibrated data the unit is pixel, in calibrated data the unit is µm. The step length 
is calculated as the dislocation of the particle from its position in the preceding frame.  
 

Show/hide path length 

Toggles display of cumulative length of the trajectory in the current frame on/off. In 
noncalibrated data the unit is pixel, in calibrated data the unit is micrometer. The path 
length is calculated as the cumulative trajectory length of the particle in all preceding 
frames.  
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2.2.4 Track Menu 

Clear current position 

Use this option to clear coordinates of the particle in the current time frame. You can 
also use the Left arrow shortcut key.  
 

Clear current trajectory 

Use this option to clear coordinates of the current particle in all time frames. This will 
entirely remove the trajectory of the current particle.  
 

Clear all 

Use this option to clear coordinates of all particles in all time frames.  
 

Next frame 

Use this option to proceed to the next time frame. You can also use the Up arrow 
shortcut key or click up the scroll arrow on the slider.  
 

Previous frame 

Use this option to go to the previous time frame. You can also use the Down arrow 
shortcut key or click the down scroll arrow on the slider. 
 

Play 

Use this option to present all time frames as a movie. Press Esc key to stop the play.  
 
 

2.2.5 Detection Menu 

Manual determination of particle position 

When Manual determination of particle position option is selected, or Enter 
shortcut key is pressed, a crosshair will appear on the screen. With the left-mouse-
click manually point to the position of the vesicle which you would like to track. 
Coordinates of the particle in the current frame are stored. Please note that the Enter 
shortcut key is available only if the image window is active (click on the image to 
activate it).  
 

Automatic detection of particle position 

Select the  Automatic detection of particle position function or use the Right 
arrow shortcut key to activate the algorithm for automatic detection of coordinates. 
Please note that the shortcut keys are available only if the image window is active 
(click on the image to activate it). The algorithm for automatic detection is functional 
only if coordinates of the current particle are determined in the preceding image. If 
not, a dialog box will open: �Please, manually determine the particle position in the 
preceding image.� 
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Continuous particle tracking 

To automatically track and proceed to the next image select the Continuous particle 
tracking function or use the Double arrow button in Toolbar. The procedure will stop 
at the last image in the series. If you want to stop the procedure before it finishes the 
tracking, release the Double arrow button. The algorithm for automatic detection is 
functional only if coordinates of the current particle are determined in the preceding 
image. If not, a dialog box will open: �Please, manually determine the particle position 
on the preceding image.� 
Note that the speed of automatic detection depends on the type of computer 
processor and on the pause settings set in the Options window under the Settings 
menu.  
 
 

2.2.6 Analysis Menu 

Show analysis results 

When the Show analysis results option in the Analysis Menu is selected, a 
separate window with a line chart will open: 

 
 
You can choose any combination of variables to be displayed on x and y axes for any 
particle (time, step length, total length, squared displacement or speed). If trajectories 
are calibrated, results are displayed in micrometers, if trajectories are not calibrated, 
results are displayed in pixels.  
 

Save all analysis results 

Use this option to save all analysis results in two separate ASCII text files. One file 
contains the summary of analysis for each particle. Data is organized in six columns 
as follows: number of the particle, total length of the trajectory, total motion time, 
average speed, displacement and index of displacement/total length of the trajectory.  
The second file with a prefix �detail_� contains analysis of each frame for all particles 
analyzed. Data is organized in columns where the first column is frame number, 
followed by 50 clusters of five columns. Each cluster represents one particle. 
Columns in a cluster represent time, step length, cumulative length, squared 
displacement and speed. If trajectories are calibrated, results are saved in 
micrometers, if trajectories are not calibrated, results are saved in pixels.  
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Save detailed analysis results 

Use this option to save the file which contains analysis of each frame for all particles 
analyzed. Data is organized in columns where the first column is the frame number, 
followed by 50 clusters of five columns. Each cluster represents one particle. 
Columns in a cluster represent time, step length, cumulative length, squared 
displacement and speed, respectively. 
 

Save analysis summary 

Use this option to save the file which contains the summary of analysis for each 
particle. Data is organized in six columns as follows: number of the particle, total 
length of the trajectory, total motion time, average speed, displacement and index of 
displacement/total length of the trajectory.  
 
 

2.2.7 Settings Menu 

Calibrate (manual) 

Use this option to manually calibrate the time interval and pixel dimensions, and 
enter appropriate scale factors.  
 

Calibrate (automatic) 

If images contain a scale bar or objects of known dimensions, you can use the 
automatic calibration procedure. After selecting the Calibrate (automatic) option, 
first click with the left mouse button to one side of the object and then to the other. 
Input the size and the unit of the object and click the Calibrate button. Pixel 
dimensions are calculated and saved.  
 

Clear calibration 

 
Use this option to clear calibration factors and to reset pixel dimensions units from 
micrometers to pixels.  
 

Assign color 

Use this option to assign a color to the current particle. Numerical particle label, the 
circular sight, trajectory and the corresponding line chart will all be displayed in the 
selected color. If no color is selected, a default color is assigned for each particle.  
 

Options 

In the Options control panel you can set, save or load several custom settings for 
particle detection and analysis:  
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Check the checkbox Proceed to next frame after automatic detection or Proceed 
to next frame after manual selection if you do not need to verify coordinates after 
every detection or selection. If these checkboxes are not checked, you can proceed 
to the next frame manually by pressing the Up arrow key. When you track particles 
by using the Continuous particle tracking, you may need extra time to verify 
coordinates in each frame. To increase the frame interval during continuous particle 
tracking, enter any value in the textbox Pause after detection (in seconds). You can 
also set to view or hide trajectories on the image, view or hide step and path length. 
Step length is a distance of particle movement in one time interval. Path length is the 
cumulative length travelled by the particle from the start to the time point of the 
current image.  
The View/hide labels checkbox toggles display of numerical labels of tracked 
particles. Labels appear next to the center of the particle.  
Use the Assign color button to assign color to any particle. Numerical particle label, 
the circular sight, trajectory and corresponding line chart will all be displayed in the 
selected color.  
In the Set maximal step box enter the maximal expected dislocation of the particle in 
one frame interval. The unit for this value is pixel. Eligible values are from 1 to 30, but 
in most cases values between 3 to 9 will allow software to successfully track 
individual particles. Select a lower value if many particles are in close proximity and a 
higher value if the expected maximal dislocation in one time interval is large.  
To calibrate the time interval and pixel dimensions, use this option and enter 
appropriate scale factors.  
 
 

2.2.8 Help Menu 

The Help menu provides access to the ParticleTR Help files. 
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Frequently asked questions 
When I press the double arrowhead button, it gets released without particle tracking. Why?  
 
The continuous particle tracking procedure can operate only when the position of the 
particle in the preceding image is determined. Check if the position of the particle is 
determined in the preceding image. If it is, than the position may be too close to the 
margin of the image (closer than the maximal step setting).  
 
The Enter shortcut key does not enable manual selection of particle coordinates.  
 
The Enter, Right arrow and Left arrow shortcut keys are active only if an image 
window is selected (active). To select an image window, click with the left mouse 
button into the image. If the cursor is in any other window, slider or textbox, shortcut 
keys are not functional.  
 
When I use the Play option, I am unable to stop playback of the time series.  
 
To stop playback, use the Esc key on keyboard.  
 
Why does the small square at the top left of the image window change color when I change 
the particle number? 
 
The square is an aid for easier identification of an active particle. Each particle is 
characterized by a unique number and color. The color of the square matches the 
color of the numerical label and the circular sight.  


